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Exercise 1: Create a LAS dataset and explore the lidar data using
ArcGIS
You are a GIS data manager working on a project for the City of Florence, a historic city in Lane County,
Oregon, United States. You have obtained lidar point cloud data in a binary LAS file format for this
project area. Now you want to conduct an initial quality check on the data by looking at its area and
coverage, and verify the current lidar classification.

Using ArcGIS you will accomplish this by creating a LAS dataset, exploring the properties of the LAS
dataset, and visualizing the LAS dataset as a point cloud and a surface in 2D and 3D. You will also
make some edits to the classification by identifying and reclassifying noise points.

A LAS dataset stores reference to one or more LAS files on disk, as well as to additional surface
features. A LAS file is an industry-standard binary format for storing airborne lidar data. The LAS dataset allows you to examine LAS files,
in their native format, quickly and easily, providing detailed statistics and area coverage of the lidar data contained in the LAS files.

A LAS dataset can also store references to feature classes containing surface constraints. Surface constraints are breaklines, water
polygons, area boundaries, or any other type of surface feature enforced in the LAS dataset. This exercise will not discuss using
breaklines. Breaklines will be utilized in the next exercise using a terrain dataset.

In this exercise, you will:

• Create a LAS dataset

• Explore the properties of the LAS dataset

• Reclassify lidar points

• View the LAS dataset in 3D

License: This data has been provided by the Oregon Department of Geology and Mineral Industries
(www.oregongeology.org) in Oregon, USA. It is a subset of a larger dataset obtained from the Oregon Lidar
Consortium, which includes federal, state, and local partners.

Part 1: Open ArcMap and create a folder connection

In these steps, you will set various options in the Catalog window in ArcMap and create a folder connection to the exercise data for this
workshop.

Steps:

1. Open ArcMap.

2. Select Cancel from the ArcMap - Getting Started window.

3. If necessary, maximize the ArcMap window.

4. Click the Catalog tab and click the pin to keep it open.

5. In the Catalog window, click the Connect to Folder button .

6. Browse to C:\Lidar_workshop\ and click OK.
You now have access to all the data and exercise folders.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
C:\Lidar_workshop\

Goal:
Learn how to create and use a LAS
dataset.
Average length of time to complete: 40
minutes.
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Part 2: Explore the project area

Using imagery you will first explore the project area in ArcGIS.

Steps:

1. In the Catalog window, expand the C:\Lidar_workshop\Database\Imagery folder.

2. Drag and drop the Florence_image.tif into the display.

3. Using the File menu in ArcMap, click Add Data > Add Basemap.
This step requires the Internet. Skip to step 9 if you are not connected to the Internet.

4. Click the Topographic basemap and click Add.

5. Ignore the Geographic Coordinate Systems Warning dialog box by clicking the Close button.
You will now adjust the transparency settings of the Florence_image layer using the Image Analysis window to explore
the study area along with the basemap.

6. Click the Windows menu and click Image Analysis to open the Image Analysis window.

7. Dock this window on the side of the application.

8. Select the Florence_image and slide the transparency slider to change the transparency of the image to 45%, thereby
allowing the basemap to show through.

9. From the Tools toolbar, using the Zoom In tool and the Pan tool , pan and zoom in to various parts of the map to
visually inspect the study area.
The study area for this exercise is a portion of Florence which is located on the Oregon Coast at the mouth of the Siuslaw
River. As you pan around, notice the study area is surrounded with beautiful, towering pine trees. Siuslaw National Forest
extends from Tillamook to Coos Bay along the Oregon Coast. The forest stretches from the lush forests of the coastal
mountains to the unique Oregon Dunes and the beaches of the Pacific Ocean. From Florence to Coos Bay, the Oregon
Dunes National Recreation Area extends for 40 miles along the Oregon Coast.

10. When you have finished exploring the study area, remove the basemap from the table of contents.

11. Click the Full Extent button on the Tools toolbar.

12. In the Image Analysis window, click the Reset Transparency button and click the pin to hide the Image Analysis
window.

Part 3: Examine LAS files

So far, you've explored the study area. Now, you will explore the lidar data you will use for the exercise.

Steps:

1. Minimize your ArcMap window.

2. Open Windows Explorer and browse to your C:\Lidar_workshop\Database\Raw LAS\FlorenceRawLASFiles folder.
Inside this folder, notice the LAS files, each maintaining specific information related to the lidar data. Each LAS file
contains metadata of the lidar survey in a header block followed by individual records for each laser pulse recorded.
ArcGIS reads LAS files natively via the LAS dataset, providing immediate access to lidar data without the need for data
conversion or import.

3. Close the Windows Explorer window.

4. Maximize ArcMap.

Part 4: Create the LAS dataset

In these steps, you will create a LAS dataset. A LAS dataset acts as a pointer to the LAS files and manages the lidar data. A LAS
dataset is stored as a binary file with a *.lasd extension.

To create a LAS dataset you can use the Create LAS Dataset tool tool or create it directly in the Catalog window (as shown below).

Steps:

1. In the Catalog window, right-click the C:\Lidar_workshop\Exercise 1 folder and click New > LAS Dataset.

2. Rename the LAS dataset to FlorenceQA.
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3. In the Catalog window, right-click FlorenceQA and click Properties.

4. Click the LAS Files tab.

5. Click Add Folders.

6. Browse to C:\Lidar_workshop\Database\Raw LAS\, click FlorenceRawLASFile, and click Add.

Try answering these questions from the information on the LAS Files tab.

What is the average point spacing of each LAS file in the LAS dataset?

___________________________________________________________

What is the highest recorded point in the LAS dataset?

___________________________________________________________

What is the version of the LAS files?

___________________________________________________________

You have just created a LAS dataset and added the LAS files. Next, you will want to calculate the statistics.

Statistics allow you to conduct initial QA/QC on lidar data to ensure the data deliverables are exactly what was expected. It
also allows you to determine the overall quality and extent of the data prior to conducting time-consuming processes on
the lidar data. The LAS dataset provides the ability to generate a fast and in-depth statistical analysis on your lidar data.

7. Click the Statistics tab.
Here you can see that no statistics have yet to be calculated for the LAS dataset.

8. Click Calculate to produce the statistics for this LAS dataset from each LAS file you added.
There is a lot of information contained within the statistics about the lidar data, such as the number of classifications (four)
and the total number of points in the files collected from each return.
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Try answering these questions from the information on the Statistics tab.

What classes are used by this data?

_______________________________

What percentage of points are recorded as Unassigned?

_______________________________________________

How many returns of the lidar data are displayed in the LAS dataset?

________________________________________________________

What percentage of points are recorded as first return points?

__________________________________________________

How many points are recorded as noise?

__________________________________

9. Click the XY Coordinate System tab.
Notice the XY coordinate system has been automatically set to Projected Coordinate Systems > State Systems >
Oregon > NAD 1983 (CORS96) Oregon Statewide Lambert (Intl Feet). The xy coordinate system has been assigned
based on the coordinate system that exists in the LAS files. The LAS standard requires the coordinate system be set in the
header of each LAS file.

10. Click the Z Coordinate System tab.

Notice the Z coordinate system has been automatically set to Vertical Coordinate Systems > North America > NAVD
1988. The z coordinate system has been assigned based on the coordinate system that exists in the LAS files. The LAS
standard requires the coordinate system be set in the header of each LAS file.

11. Click OK to close the LAS Dataset Properties dialog box.

Part 5: Examine LAS dataset

Now that you've created the LAS dataset, you will add it to ArcMap and examine the data.

Steps:

1. In the Catalog window, click and drag the FlorenceQA LAS dataset to the ArcMap window.
By default, the LAS dataset will display the LAS file extent outlines as a wireframe.
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The wireframe is visible when the estimated number of points is too large to display and would therefore take too long to
read from disk. You can zoom in to a smaller area to see the points.

2. In the table of contents, right-click the FlorenceQA layer and click Properties.

3. In the Layer Properties dialog box, click the Display tab.
The Rendering Preferences allow you to optimize the amount of lidar points rendered by the LAS dataset in ArcMap.

4. Increase the Point limit to 1000000.
This limits the number of points used in the triangulation of the LAS dataset layer surface.

5. Increase the Point Density to Fine.
This option controls the density of points enforced by the LAS dataset.

6. Check Use scale to control full resolution.

7. Change the Full Resolution Scale to 3000.
This is a scale threshold used to control when the LAS dataset will render itself without thinning, using 100 percent of the
LAS points. It is used when the map scale is equal to or greater than the scale you specify. The point limit is still honored
though, so if the number of estimated points for the current extent exceeds the limit, the LAS dataset will thin itself and not
draw using all the data. When this occurs, an asterisk is displayed next to the data percentage listed for the layer in the
table of contents. When the map display scale is less than the full resolution scale, thinning will occur based on the setting
of the Point Density slider bar.

8. Under the LAS File Extents section, check Always display LAS file extents and check Display LAS file names.

9. Click OK to close the dialog box.

10. To use the LAS Dataset toolbar, which you will open next, you need to enable the ArcGIS 3D Analyst extension. On the
main menu, click Customize > Extensions and check 3D Analyst; then close the dialog box.

11. Click Customize > Toolbars > LAS Dataset to open the LAS Dataset toolbar.

12. Zoom in to an area at a scale of approximately 1:2,500 to examine the points.
The points will be displayed and color-coded by elevation.

13. Click the Filters drop-down menu and click Ground to view the ground points only.
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14. Click the surface and click Elevation .

You are viewing a triangulated irregular network surface of only points representing ground.

Take some time to examine the different ways to render the points, such as looking at the nonground points and slope.

Part 6: Edit the LAS classification codes

The current lidar files contain five class codes: Unassigned (represents nonground), Ground, Water, Noise, and Reserved. The
Reserved class code is incorrect and should be classified as Noise. In these next steps you will reclassify them using a geoprocessing
tool.

Steps:

1. Click the Geoprocessing menu and click Geoprocessing Options.

2. Uncheck Enable to disable background processing so you can watch the processing.

3. Click OK to close the window.

4. Click the Search button on the Standard toolbar.

5. Click Tools on the top of the Search window.

6. Type LAS Class Codes in the Search window and press ENTER.

7. Click Change LAS Class Codes (3D Analyst) in the returned search list to open the tool.

8. Click the Input LAS Dataset drop-down arrow and click the FlorenceQA layer.

9. In the Class Codes text box, type 10, and click the Add button .

10. Under New Class codes, type 7.
7 is the class code for noise.

11. Check Compute Statistics.

12. Click OK to run the tool.

13. Optionally, check the properties of the LAS Dataset to view the changes to the statistics.

Part 7: View profiles of the lidar points

Steps:

1. Click the Filters drop-down menu and click All to view the ground points only.

2. Click the surface and click Elevation .

3. Click the Full Extent button on the Tools toolbar.
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4. Use the Zoom In tool to zoom in to the bridge going across the river at the bottom of the image.

5. In the LAS Dataset toolbar, click the LAS Dataset drop-down menu and click Profile Tool Options.

6. Change the Point budget to 150000.
The Point budget controls the maximum number of points that can be used in the 2D Profile View window.

7. Click the Point View Display Options drop-down list and click Class .

By viewing the points by their classification you will easily be able to pick out the points you want to reclassify.

The next several steps involve reclassifying a bridge to the correct classification code. You will need to have the imagery
available to verify exactly where the bridge is located.

8. In the table of contents, reorder the layers so the Florence_image.tif is listed above the FlorenceQA.lasd.

9. Click the Image Analysis tab to show the Image Analysis window.

10. Click the Florence_image.tif in the layer list in the Image Analysis window.

11. Using the Transparency slider , change the transparency of the image to 40 percent.

The blue area represents points classified as water. You can now see that the bridge has been misclassified as water
(circled in yellow below).
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12. Zoom in to a scale of approximately 1:3,000.

13. Click the LAS Dataset Profile View button on the LAS Dataset toolbar.

14. With the crosshairs active, click a location in the center of the north edge of the bridge that represents the starting point of
the LAS dataset profile graph.
A small information box appears at the top of the display window, interactively showing the current length of the line.

15. Click a location in the center of the south edge of the bridge that represents the ending point of the LAS dataset profile
graph.
Once an ending point has been selected, a selection box appears allowing you to move the pointer until the box is at a
desired profile width. The actual dimensions and point count for the selection box are displayed in the information box at
the top of the display window. These values change interactively as you move the pointer over the point set. The units of
the displayed width correspond to the coordinates of the data being used for the analysis. When a maximum point count is
reached, you cannot make the selection box any larger.

16. Click a third location to represent the width of the profile graph. The width should contain approximately 100,000 points.

The LAS Dataset Profile View window opens and displays the profile along the bridge. This window allows you to view
and edit the classification of the lidar points of the LAS dataset.

17. Click the Select By Polygon button at the top of the Profile View window and use the tool to select the points
representing the bridge.
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Press SHIFT to make multiple selections.

18. Click the Edit button to launch a dialog box to edit the class codes of the points you have selected.

19. Click the number 1 button and click Apply.
This will change the classification code for all the selected points to the Unassigned code (representing all aboveground
points) and update the profile view.

20. Close the Profile View window.

21. Uncheck the Florence_image.tif in the table of contents to turn off the layer.

22. Click the Refresh button at the bottom of the display view.

You should now see a gray strip of points representing the bridge.

Part 8: View the updated points in 3D

You can further examine the points in ArcMap using the 3D View window.

Steps:

1. Click the LAS Dataset 3D View button on the LAS Dataset toolbar.
The extent in the display view will be displayed in the 3D View window.
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2. Using the Navigate tool you can look at different angles around the bridge.

3. Click the Measure tool from the 3D View toolbar to measure height and distance between two locations.

4. Click a starting point to begin the measurement in the 3D View window.

5. Double-click in the 3D View window to finish the measurement.
The distance of the measurement and the height difference between the starting point and ending point are displayed in
the 3D View window.

6. You can close ArcMap (without saving).

You have now examined the lidar data for the Florence project area and made corrections to the classifications. It is now ready for any
future project work. In the next exercise you will look at another study area, in which you received lidar data, using the terrain dataset.
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Exercise 2: Create a terrain dataset and analyze the data
After having verified your lidar data for a project in Florence, Oregon, you have another lidar dataset for
a project near Laguna Niguel, California, you would like to examine and manage using a terrain dataset
in ArcGIS. The data in Laguna Niguel has already been quality tested using a LAS dataset and is ready
to be imported into the geodatabase for further management and analysis. These two datasets will also
be added to a mosaic dataset in a later exercise to be shared within or outside your organization.

A terrain dataset is a multiresolution, TIN-based surface built from measurements stored as features in a geodatabase. They're typically
made from lidar, sonar, and photogrammetric sources. Terrain datasets reside in the geodatabase, inside feature datasets with the
features used to construct them. Terrain datasets can be useful in defining, managing, and visualizing a surface based on vector
measurements. The terrain dataset is scalable and seamless, with collections reaching into billions of measurements. Terrain datasets live
next to the source measurements from which they are created, which allows for localized-based updates to the surface model over time.

In this exercise, you will:

• Create a geodatabase and feature dataset.

• Import ground lidar points into a multipoint feature class.

• Build a terrain dataset using the ground-based multipoints.

• Examine the terrain dataset.

• Conduct interactive surface analysis.

• Create an intensity image from the first return points.

In this section of the course, you will learn how to create, visualize, and analyze terrain datasets in ArcGIS. You will also learn how to take
advantage of the performance, efficiency, and scalability capabilities of terrain datasets.

License: This data has been provided by the City of Laguna Niguel in California, USA, and was collected by
Pictometry.

Note: Background processing should be disabled for all geoprocessing tools.

Part 1: Create a file geodatabase and feature dataset

Terrain datasets reside in a geodatabase feature dataset. In this step, you create the file geodatabase and the feature dataset where
the terrain dataset will be created.

A geodatabase is a collection of geographic datasets of various types and is a native data storage and management framework for
ArcGIS. It acts as an organizational tool to store and manage large lidar datasets and terrains and is also the gateway into advanced
GIS capabilities. It provides a central scalable data storage and management system with better data integrity, backup, recovery, and
security.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
C:\Lidar_workshop\

Goal:
Learn how to create and use a terrain
dataset.
Average length of time to complete: 50
minutes.
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Steps:

1. Open ArcMap.

2. Open a new map document in ArcMap. In the Getting Started dialog box, click Cancel to open a new map document.

3. If necessary, turn on the ArcGIS 3D Analyst extension. On the main menu, click Customize > Extensions and make sure
3D Analyst is checked.

4. In the Catalog window, browse to the C:\Lidar_workshop\Exercise 2 folder.

5. Right-click the folder and click New > File Geodatabase.

6. Rename it to LagunaEx.

7. Right-click the geodatabase and click Make Default Geodatabase.
The default geodatabase is the home location for the spatial content of your map. This location is used for adding datasets
and saving resultant datasets created by various editing and geoprocessing operations. The default geodatabase is
synchronized with Current Workspace of the Geoprocessing Environments; therefore, all output from tools or models will
be saved to this default location.

Access to the default geodatabase is available from the Catalog window menu, and as a shortcut in dialog boxes, so you
can quickly get back to the default geodatabase if you browsed elsewhere in the system.

8. Right-click LagunaEx and click New > Feature Dataset.

9. Type Terrain as the Name and click Next.

10. Expand Projected Coordinate Systems > State Plane > NAD 1983 (US Feet), click NAD 1983 StatePlane California VI
FIPS 0406 (US Feet), and click Next.

11. Expand Vertical Coordinate Systems > North America and select NAVD 1988 (US survey feet).

12. Click Next.

13. Accept the default values for XY Tolerance and click Finish to create the feature dataset.

Part 2: Import lidar ground points into a multipoint feature class

A multipoint is an ArcGIS geometry type that can be used to store many points in an individual database row. This reduces the number
of rows in the feature class table, which improves overall performance. A few thousand records can store millions of lidar points.
Multipoint feature classes are beneficial because many points can be handled at one time, thereby saving storage space and improving
read-write performance.

A 3D Analyst geoprocessing tool named LAS To Multipoint can be used to create a multipoint feature class from lidar data stored in LAS
files.
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Steps:

1. Click the Search button on the Standard toolbar.

2. Click on Tools on the top of the Search window.

3. Type LAS to Multipoint and press ENTER.

4. Click LAS To Multipoint (3D Analyst) in the returned search list to open the tool.

5. From the tool dialog box, click the drop-down arrow for the Input Browse for parameter and click Folders.

6. Click the Input browse button , browse to C:\Lidar_workshop\Database\RawLAS, click the LagunaRawLASFiles
folder, and click Add.

7. Click the Output Feature Class browse button , browse to the Terrain feature dataset created in Part 1, enter the name
Masspoints, and click Save.
All feature classes contributing to a terrain dataset must reside in the same feature dataset. It is recommended that you
set the output feature class to be the feature dataset where the terrain dataset will be created.

8. In the Average Point Spacing text box, type 2.5.
The Average Point Spacing is the average 2D distance between points in the input LAS files. This can be an
approximation. If areas have been sampled at different densities, specify the smaller spacing. The value needs to be
provided in the projection units of the output coordinate system. If the point spacing is not known, use the Point File
Information tool or the LAS dataset provided to determine the point spacing of your data. To examine the LAS dataset for
the Laguna LAS files, expand Lidar_workshop > Database > LASDatasets in the Catalog window. Double-click the
Laguna.lasd to show the properties. Click the LAS Files tab to determine the average point spacing.

9. In the Input Class Codes text box, enter 2 and click the Add button .
You are creating a terrain dataset that will use only the ground lidar points. A class code of 2 represents ground, and will
therefore ensure that only ground points are imported into the geodatabase multipoint feature class.

10. In the Input Return Values box, check ANY_RETURNS.

11. Click the Input Attribute Names drop-down arrow and click INTENSITY, RETURN_NUMBER, and CLASSIFICATION.

Use the default settings for the remaining parameters on the geoprocessing tool.

12. Click OK to run the tool.

13. After the process is finished the multipoint feature class will be added to the table of contents. Uncheck the Masspoints
layer to turn off the multipoints in the display window.

The complete dialog box may not close right away when you click close if the masspoints layer is still drawing itself in the
ArcMap display. This process could take up to 30 seconds.

14. Right-click the Masspoints layer in the table of contents and click Open Attribute Table.

15. In the Table window, click the Options button and click Turn All Fields On to see the complete table for the multipoint
feature class.
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How many points are being stored in each geodatabase row?

___________________________________________________________

What additional lidar information did you import into the multipoint feature class along with the points?

___________________________________________________________

Why is it useful to store this information with the lidar points?

___________________________________________________________

16. Close the Table window.

17. Right-click the Masspoints layer in the table of contents and click Remove.

These multipoints along with breaklines will be used to represent the terrain dataset surface model which you will create later.

Part 3: Import breaklines

The ability to store and manage vector-based surface information in the geodatabase is a benefit of using terrain datasets. Terrain
datasets can incorporate vector data from different sources and triangulate it on the fly, including breaklines. Breaklines define and
control surface behavior in terms of smoothness and continuity. They have a significant effect in terms of describing surface behavior
when incorporated in a surface model. Breaklines can describe and enforce a change in the behavior of the surface. Z-values along a
breakline can be constant or can vary throughout its length.

Traditionally, breaklines were used in surface models to represent all kinds of linear features. With lidar, they are mostly used for hydro
enforcement or to define a study area. The higher resolution the lidar, the less need for breaklines unless the application is water
related. Breaklines are important for maintaining the definition of water-related features in an elevation model. Breaklines are used to
capture linear discontinuities in the surface, lake shorelines, single-line drains for small rivers, and double-line drains for large rivers.

In these steps, you will add a study area boundary and a river to the feature dataset.

Steps:

1. In the Catalog window, right-click the Terrain feature dataset and click Import > Feature Class (multiple).

2. Click the Input Features browse button and browse to C:\Lidar_workshop\database\LagunaEx.gdb\Terrain.

3. Press and hold the CTRL key, and select both the Extent and River feature classes. Once both feature classes are
highlighted, click Add.

4. Click OK to run the tool.
By default, the feature dataset is added as a group layer in the table of contents, when the tool is finished. Feel free to
examine these layers.

5. Right-click the group layer in the table of contents and click Remove.

Two new feature classes have been added to the Terrain feature dataset. Now you have three feature classes to use in building a
terrain dataset surface model. The Extent feature class represents the boundary of the study area, while the River feature class
represents the river that exists in your study area.
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Part 4: Create a terrain dataset

The Catalog window provides access to the New Terrain wizard to create a terrain dataset. In this step you will use the New Terrain
wizard to create a terrain dataset from the three data sources you added to the Terrain feature dataset.

Steps:

1. Right-click the Terrain feature dataset and click New > Terrain to launch the New Terrain wizard.

Caution: If a message box opens with information about a schema lock, restart ArcMap and restart the
exercise from this step. You do not need to save the map document.

2. Type GroundTerrain for the Name.

3. The feature classes within the feature dataset are listed in the selection window. Select all three feature classes.

4. Type 2.5 for the average distance between points in feet.

5. Click Next.

6. Click the Advanced button.
Normal settings:

• Height Source—Indicate whether the feature class has a height value. For example, if the heights are to come
from the shape geometry, select the SHAPE field.

• Surface Feature Type (SF Type)—Define how each feature class is to contribute to the terrain dataset.

Advanced settings:
• Overview—A generalized representation of the terrain, similar to a thumbnail image. Indicate which feature

classes will be used in the overview scene of the terrain dataset.

• Anchor Points—Point in a feature class that remains through all pyramid levels of a terrain dataset. These points
will never get filtered or thinned away.

• Group—Give specific group values to line or polygon features if they represent different levels of detail for the
same thematic role (for example, a high- and low-resolution clip polygon).

• Embedded—Indicate whether a feature class containing mass points is to be embedded into the terrain dataset.

• Embedded Name—Name of the embedded feature class.

7. Change the SFType for the River feature class to hard replace by selecting the current SFType listed in the window.

8. Scroll across to the Embedded column. For the Masspoints feature class, change this option to Yes.
The lidar points will now be embedded into the terrain dataset, which will provide access to the lidar attributes that were
imported into the multipoint feature dataset.

ArcGIS 10.2 Lidar Workshop

Copyright © 1995-2013 Esri. All rights reserved. 17



9. Click Preserve Embedded Fields, select all fields, and click OK.

10. Click the Next button to show the pyramid type selection window.
Pyramids are levels of detail generated for a terrain dataset to improve efficiency. They are used as a form of scale-
dependent generalization. Pyramid levels take advantage of the fact that accuracy requirements diminish with scale.
Terrain dataset pyramids are generated through the process of point reduction, also known as point thinning. This reduces
the number of measurements needed to represent a surface for a given area. For each successive pyramid level, fewer
measurements are used, and the accuracy requirements necessary to display the surface drops accordingly. The original
source measurements are still used in coarser pyramids, but there are fewer of them. No resampling, averaging, or
derivative data is used for pyramids.

Two pyramid types exist: Z Tolerance and Window Size. The Z Tolerance pyramid type utilizes vertical tolerance in the
definition of the terrain surface resolution. Each pyramid level is a vertical accuracy approximation of the full-resolution
data. Using the Window Size pyramid type, the resolution is defined by equal-area windows at each pyramid-level scale
range, controlling the horizontal sample density.
It takes time to produce pyramids, so you need to consider how best to use them to your advantage. For this exercise, we
are going to use a window-size pyramid type with a Z Minimum selection method to represent the ground surface model
being created.

11. Click the Point selection method drop-down arrow and click Z Minimum.

If the window-size pyramid type is selected, you can optionally indicate whether further point thinning is required using the
Secondary thinning method. The Secondary thinning method is used to further thin mass points over relative flat
surfaces. A Secondary thinning threshold is required to specify the maximum difference a z point can be from the
selected window-size point to be thinned out of the terrain dataset.

12. Click the Secondary thinning method drop-down arrow and click Mild.
Accept the default of 1 as the Secondary thinning threshold.

13. Click the Next button to show the pyramid properties selection window.

14. Click the Calculate Pyramid Properties button.
The terrain pyramid levels are set for the terrain dataset on this dialog box. The column indicating Maximum Scale is a
reference scale threshold. A pyramid level is used to represent a terrain dataset between its reference scale and the
reference scale of the next coarsest level. The column indicating the pyramid type will change depending on the identified
pyramid type. The window-size pyramid-level resolution is defined by equal-area windows at each pyramid-level scale
range. The highest-resolution pyramid level should use a window size equal to or larger than the average point spacing.
Clicking the Calculate Pyramid Properties button will estimate default values. The estimation is based on the
approximate point spacing provided and the x,y extents of the data.
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15. Click Next to review a summary dialog box displaying the settings used to build the terrain dataset and click Finish.

16. Click Yes to build the terrain dataset.

The terrain dataset build process should be approximately one minute for this dataset. When the terrain dataset is finished being
generated, it will be added to the feature dataset next to the source data from which it was created. Next, you will explore the surface
model in ArcMap.

Part 5: Adding and exporting the terrain dataset in ArcMap

Terrain datasets can be visualized in ArcMap through a terrain layer. This layer type is similar to TIN layers in some regards: it supports
multiple renderers. You can view the triangles colored by elevation range, slope, aspect, and hillshade. You can also see the breaklines,
triangle edges, and nodes of the triangulated surface. In terms of differences, terrains have the level of detail (LOD) capability that helps
speed up the display, particularly at small scales, when a large volume of data is involved. The layer's surface representation updates
itself automatically as you pan and zoom around the display. TINs are built on the fly based on measurements and level of detail (LOD)
information stored in the geodatabase.

Now you will explore the levels of detail of the terrain built in the last exercise and explore the analysis tool available on the 3D Analyst
toolbar.

Steps:

1. In the Catalog window, click and drag the terrain dataset from the Catalog window into the ArcMap display.

2. Look at the table of contents. Notice the terrain is being displayed as an Overview Terrain surface model.
An overview terrain is displayed initially when the terrain dataset is added to ArcMap. The overview terrain is the coarsest
representation of the terrain dataset and is intended for fast drawing at small scales. The overview is what is drawn by
default when zoomed to the full extent of the terrain dataset. It is a vector-based thumbnail representation.
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3. Click the Zoom In tool on the Tools toolbar, and zoom to the area depicted below, where the river meets the ocean
boundary.

As you zoom in you can see the terrain is being built on the fly. These measurements are triangulated and drawn on-
screen depending on the resolution. When going from a coarser pyramid level to a more detailed level, only the source
measurements needed to get to the higher-detailed pyramid level are retrieved and added to the triangulations.

4. Look at the table of contents. Notice the terrain is now being displayed using a Window Size pyramid level.
If zoomed to the area below, you can see the enforcement of the breaklines in the data, as shown below in the yellow box.
The river and ocean boundary has been enforced in the surface model.

You can see the current resolution of the terrain displayed in the table of contents changing as you zoom in or pan around
the data. In this case, you are using a window-size sampling method, or horizontal sample density, of the currently
displayed pyramid level.

5. Use the Zoom In tool and Pan tool from the Tools toolbar to pan and zoom to the various parts of the terrain dataset
to visually inspect the study area. Notice the Window Size value changes accordingly.

6. Click the Zoom In button on the Tools toolbar and zoom in until the Window Size is 0.00.
This surface is now at full resolution, where no thinning has been done.

Terrain pyramids are like raster pyramids in concept and purpose (less data for small-scale use), but the implementation is
different because they are vector based. They can also be used in analysis which is valuable if the full resolution data
happens to be oversampled for the needs of your application.

Now you'll examine the layer properties of the terrain dataset.
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Part 6: Examine the terrain dataset layer properties

Steps:

1. Right-click the GroundTerrain layer in the table of contents and select Properties.

2. Click the Source tab to answer the following questions.
How many pyramid levels are there (levels of detail)?

___________________________________________

How many total points are there in the terrain dataset?

___________________________________________

What is the coordinate system of the terrain dataset?

___________________________________________

3. Click the Symbology tab.

4. Click the Add button.

5. Highlight the Contour with the same symbol renderer and click Add.

6. Click Dismiss to close the Add Renderer dialog box.

7. Click OK to accept the contour display defaults and to close the Layer Properties dialog box.
Contour lines are added to the surface model.

8. From the Tools toolbar, use the navigation tools to browse throughout the surface and examine the contour lines.

9. To turn off the contour lines, right-click the GroundTerrain layer in the table of contents and click Properties.

10. Click the Symbology tab.

11. Uncheck Contour in the Show box.

12. Click the Analysis tab.
The Analysis tab offers settings for using the tools on the 3D Analyst toolbar. By default, the analysis tools are only
enabled when the terrain dataset is at full resolution, a value of 0.

Clicking the drop-down arrow allows you to set a resolution threshold for the interactive tools on the 3D Analyst toolbar.
The tools are only enabled for use on the terrain surface when its display resolution is equal to or better than what's
specified here.

You know that the full-resolution lidar data is oversampled for the interactive analysis conducted in the next section.
Therefore, you are going to change this setting to work with the 3D Analyst toolbar appropriately.

13. Click the analysis drop-down menu and click 20.

14. Click OK to close the Layer Properties dialog box.
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Part 7: Use the 3D Analyst toolbar

In this section you will use a few of the 3D surface analysis tools available on the 3D Analyst toolbar to conduct a line-of-sight analysis
and a profile analysis.

Steps:

1. Click Customize > Toolbars > 3D Analyst to open the 3D Analyst toolbar.
The following interactive tools exist on the 3D Analyst toolbar for surface analysis with the terrain dataset.

• Create Contours

• Create Steepest Path

• Create Line of Sight

• Interpolate Point

• Interpolate Line

• Interpolate Polygon

• Create Profiles

2. From the Tools toolbar, use the Zoom In tool and zoom in until the terrain dataset displays a Window Size of 20.00
(the scale is approximately 1:10,000). Perhaps zoom in to the valley area around the river. Try to ensure the display also
shows the surrounding hills.

3. Click the Interpolate Line button .

4. Draw a line on the terrain dataset by clicking on a start location and double-clicking at the end location. Try and draw the
3D line from the peaks of the hills covering the valley.

5. Click the Profile Graph button to display a 2D profile of the digitized 3D line.
Notice the results of the profile graph. It shows the gentle slope of the valley between two hills.

6. Close the Profile Graph window.

7. Delete the 3D line representing the line-of-sight results.
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8. Use any of the navigation tools on the Tools toolbar to zoom in to the area displayed by the yellow box in the graphic
below.

9. Click the Create Line of Sight button .
You will now conduct a visibility analysis from a hilltop to a roadway using the Create Line of Sight tool . The analysis
will be conducted from (observer) a hilltop to (target) a roadway.

10. On the Line Of Sight dialog box, type a value of 30 feet to represent the Observer offset.

11. On the Line Of Sight dialog box, type a value of 5 feet to represent the Target offset.

12. Click the surface at the observer location. Try and select the starting point as indicated by the black dot in the graphic
below. Make sure to hold down the left mouse button.

13. Move the crosshairs of the cursor to the target location and release the left mouse button at the target location. Try and
position the crosshairs on the roadway as indicated in the graphic below.

A colored line appears indicating what is and what is not visible along the identified path from the observer location to the
target location. The following list describes the colors used to represent different portions of the 3D line.

• The black dot is the location of the observer.

• The blue dot is the point of obstruction from the observer to the target.

• The green dot is the location of the target. If the target is green it is visible from the observer. If the target is red it
is not visible from the observer.

• The red lines are obstructed areas from the observer point.

• The green lines are visible areas from the observer point.

The 3D line is symbolized with red to represent obstructed areas from the observer point and green to depict visible areas
from the observer point. The profile graph displays the elevation change between the observer and target locations, as
well as the visibility that exists from the roadway locations.

14. With the graphic selected, click the Profile Graph button . The profile graph appears.
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You can see that same line in a 2D profile view. The line is symbolized with the same colors as the line-of-sight results on
the terrain dataset surface.

15. Close the Profile Graph window.

16. Delete the 3D line representing the line-of-sight results.

17. Close the Line Of Sight dialog box.

A variety of analytic operations can be performed on terrain datasets using the 3D Analyst toolbar. Interactive tools provide the ability
to explore the terrain surface visually.

Part 8: Create a lidar intensity image

Intensity is a measure, collected for every point, of the return strength of the laser pulse that generated the point. It is based, in part, on
the reflectivity of the object struck by the laser pulse. Other descriptions for intensity include return pulse amplitude and backscattered
intensity of reflection. Keep in mind, reflectivity is a function of the wavelength used, which is most commonly in the near infrared.
Intensity is used as an aid in feature detection and extraction, in lidar point classification, and as a substitute for aerial imagery when
none is available. If your lidar data includes intensity values, you can make images from them that look something like black-and-white
aerial photos. ArcGIS provides the ability to create intensity imagery from lidar data.

It is common to use first return lidar data to create intensity images. The LAS To Multipoint tool was used to import all the lidar points for
the study area into a multipoint feature class with intensity.

You are now going to create an intensity image for the study area from the multipoint.

Steps:

1. Click the Search button on the Standard toolbar.

2. Click Tools on the top of the Search window.

3. Type Point to Raster in the Search window and press ENTER.

4. Click Point to Raster (Conversion) in the returned search list to open the tool.

Caution: There is a tool named Raster To Point—make sure you haven't opened it
instead.

5. Click the Input Features browse button .

6. Browse to the C:\Lidar_workshop\database\LagunaEx.gdb\Terrain and select masspoints_all to highlight the
multipoint feature class.

7. Click the Add button.

8. Click the Value Field drop-down menu and click Intensity.

9. Click the Output Raster Dataset browse button .

10. Browse to the C:\Lidar_workshop\exercise 2 folder.

11. Type intensity.tif as the Name for the image and click Save.

12. Click the Cell assignment type drop-down menu and click MEAN.

13. For the Cellsize type 9.
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14. Click OK to run the tool.
The intensity raster will automatically be added to the ArcMap display.

15. Turn off the GroundTerrain layer in the table of contents so that only the intensity layer is turned on. Notice the area of
water in the pacific ocean. The ocean is highlighted in the graphic below with a yellow polygon.

When a lidar system is flown over water a large amount of the laser energy is absorbed and does not reflect back to the
lidar system. Some lidar points will hit in a way, often in dirty water or broken water, that will allow some energy to return to
the lidar system. The amount of energy returning will be small, and will give a low value for intensity, which will display in
gray scale as very dark. Also, over water, directly under the aircraft, you generally get more returns due to the laser
reflecting off the water, a bit like a mirror, directly back up to the lidar system. In this area, you get a larger range of
intensity returns, typically producing a stripe effect. You will see a lot of points under the plane and no points out to the
edge of the scans. In any case, lidar data over water is unreliable and produces very noisy elevation data. It is usually
omitted from any surface analysis.

16. Use any of the navigation tools on the Tools toolbar to zoom in to the area displayed by the yellow box in the graphic
below. You are going to examine the intensity image of the streets around the Laguna Niguel hills.

17. Examine the roadways and buildings in this area. This type of information assists with visually inspecting the features
included in the lidar point cloud. For example, the intensity image can assist with classifying lidar points. You are able to
examine the features displayed in the intensity image and be able to determine which type of feature it is, either ground,
roads, buildings, vegetation, and so on. You can then classify the points accordingly. The image below depicts these
features.
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18. Right-click the intensity layer in the table of contents and select Properties.

19. Click the Symbology tab.

20. Click the Display NoData As drop-down arrow and change the color to red.

21. Click OK to close the Layer Properties dialog box.
Now the intensity image displays areas where NoData is available as red cells. Look for data voids throughout the intensity
image as red locations. It is expected that areas around water features display data voids. However, areas where land
cover exists, data voids are not as common. Have your vendor explain anything that doesn't look right.

The process of displaying data voids is another basic QA/QC process you can do with ArcGIS when you receive lidar data.
It is good practice to ensure the lidar points delivered by your data provider have the coverage you expected.

22. You can close ArcMap (without saving).

In this exercise, you have learned about terrain datasets and their support for lidar data in ArcGIS. You were able to generate a
geodatabase feature dataset and import all source measurements that were used to build a highly accurate surface model. This exercise
demonstrated how to build a terrain dataset and use the surface model for interactive and advanced analysis and visualization. In the next
exercise, you will explore the mosaic dataset and its support for lidar in ArcGIS.
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Exercise 3: Create a mosaic dataset and explore the data
Organizations often have lidar data for multiple areas, captured at different times, and captured for
entirely different projects. One of the issues with all this data is how to manage it and provide
access—for which the mosaic dataset is ideal. In this exercise you will create a mosaic dataset to
manage, visualize, and provide access to the lidar data used in both exercises.

A mosaic dataset can be a collection of raster and lidar datasets stored as a catalog and viewed or
accessed as a single mosaicked image or individual images. These collections can be extremely large,
both in total file size and number of raster or lidar datasets. The datasets in a mosaic dataset can remain
in their native format on disk or, if required, be loaded into the geodatabase. Mosaic datasets have
advanced raster querying capabilities and processing functions and can also be used as a source for serving image services.

In this exercise you will:
• Create multiple mosaic datasets to view bare earth and surface features.

• Add the lidar data to the mosaic dataset.

• Create a visually appealing image using the Shaded Relief function.

• Examine the surface difference.

• Query and download.

In this section of the course you will learn how to manage and visualize the lidar data with a mosaic dataset, how to process the data
using functions to create elevation models for further processing and analysis, and how to access the raw data.

Part 1: Create the mosaic dataset

A mosaic dataset is stored within a geodatabase, so in these steps, you will first create a file geodatabase and then create the mosaic
dataset.

Steps:

1. Open ArcMap.

2. In the Catalog window, browse to C:\Lidar_workshop\Exercise3.

3. Right-click the folder and click New > File Geodatabase.

4. Rename the geodatabase to LidarCollection.

5. Right-click the geodatabase and click Make Default Geodatabase.

6. Right-click the geodatabase and click New > Mosaic Dataset.
This opens the Create Mosaic Dataset tool.

7. Type BareEarth in the Mosaic Dataset Name text box.

8. Click the Coordinate System browse button .

9. Expand Projected Coordinate Systems > World, click WGS 1984 Web Mercator (auxiliary sphere), and click OK.
The spatial reference system is used to generate the footprints, boundary, and other related items in the mosaic dataset.
You should choose one that is suitable for all the data you add. This could be a country system or UTM zone. However, if
you're creating a mosaic dataset that may be global in extent or will be mashed up with web services, you will want to use
the WGS 1984 Web Mercator Auxiliary projection, which is why this one was chosen.

10. Click OK to run the tool.
The BareEarth mosaic dataset is created in the geodatabase and added to the ArcMap table of contents. This is an empty
mosaic dataset. You will be adding the lidar data to it in the next steps.

11. Uncheck the Image layer in the table of contents, since there is more to be done before you explore this layer.

When the mosaic dataset is added to the table of contents, it is added as a mosaic layer, which is essentially a special group layer. The
top level has the name of the mosaic dataset—BareEarth. There are also empty Boundary, Footprint, and Image layers, which you will
explore later.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
C:\Lidar_workshop\

Goal:
Learn how to create and use a mosaic
dataset containing lidar data.
Average length of time to complete: 40
minutes.
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Part 2: Add the LAS files from the first project area

You can add the raw LAS files, a LAS dataset, or a terrain dataset to a mosaic dataset. In this exercise you will only add the lidar data
from the original LAS files. If you needed to build a mosaic dataset from data that used constraint, then the LAS dataset or terrain
dataset is recommended. The parameters used to add all three types of data to the mosaic dataset have similar parameters.

When you add the data to this mosaic dataset you will create a bare earth surface. (Note this can be changed if required at a later time.)

Since the point spacing and projections are different for each project area, you will add the two project areas separately.

Steps:

1. In the Catalog window, right-click the mosaic dataset and click Add Rasters.
The Add Rasters To Mosaic Dataset tool opens.

Dive-in: Although the lidar data are points, not rasters, this tool is used since all files are visualized and
analyzed as raster data in a mosaic dataset.

2. Click the Raster Type drop-down list and click LAS.
Raster types define more than the file format information for the data that is being added to the mosaic dataset. Each
raster type is customized with the necessary parameters and processing functions, along with knowing the metadata that
should be populated in the attribute table.

Notice the warning symbol that appears next to the parameter. This appears because there are properties that need to be
set when using this raster type; therefore, you cannot run this tool without setting these properties.

3. Click the Edit Raster Type Properties button .

4. Click the LAS tab.

5. Verify that the Return types is Any.

6. For the Class types, select 2. Ground.

7. For the Pixel size, type 6.
The average point spacing for this lidar dataset is approximately 1.5. It is better to go with a pixel size several times larger
than the average point spacing but small enough to identify gaps or voids. Generally, if the pixel size is three or four times
greater than the point spacing, the voids in the data should be filled (unless, for example, the voids are due to water).

8. Click the Void filling drop-down arrow and select Plane Fitting / IDW.

Dive-in: You can also generate intensity images from the LAS files by changing the Data type from LAS
Data Z to Las Data Intensity.

9. Check Treat each folder as a dataset.
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This will add all the files in a folder as a single item in the mosaic dataset, which is more efficient for the mosaic dataset.
You may choose to check this option if all the LAS files in a folder belong together and have the same spatial reference.
For example, they may represent a single data collection (project) that is just stored as tiles.

10. Click OK to close the dialog box.

11. Verify that Workspace is selected in the Input Data drop-down menu.

12. Click the Input Data browse button , browse to C:\Lidar_workshop\Database\RawLas\, select the
FlorenceRawLASfiles folder, and click Add.

13. Expand the Advanced Options and click the Coordinate System for Input Data button .

14. Expand Projected Coordinate Systems > State Systems > Oregon, click NAD 1983 (CORS96) Oregon Statewide
Lambert (Intl Feet), and click OK.

15. Click OK to run the tool.
The LAS files are added to the mosaic dataset. The footprint and the boundary are generated. The footprint contains the
extent of the LAS file project area. The boundary currently contains the same extent, but technically defines the extent of
all the datasets, defined by their footprints, within the mosaic dataset.

16. Once completed, uncheck the Image layer in the table of contents, right-click the Footprint layer, and click Zoom To
Layer to see the footprint for the LAS data.

Part 3: Add the LAS files from the second project area

In these steps you will add the second project area. This area is added separately because it has a different average point spacing and
projection.

Steps:

1. In the Catalog window, right-click the mosaic dataset and click Add Rasters.
The Add Rasters To Mosaic Dataset tool opens.

2. Click the Raster Type drop-down list and click LAS.
You will need to set similar properties as you did earlier.

3. Click the Edit Raster Type Properties button .

4. Click the LAS tab.

5. Verify that the Return types is Any.

6. For the Class types, select 2. Ground.

7. For the Pixel size, type 12.
The average point spacing for the LAS files is 3, so you're choosing a value that is four times larger. Also note that this is
not the same as the pixel size used by the first dataset you added. The mosaic dataset supports multiple resolutions of
data within it.

8. Click the Void filling drop-down arrow and select Plane Fitting / IDW.

9. Check Treat each folder as a dataset.

10. Click OK to close the dialog box.

11. Verify that Workspace is selected in the Input Data drop-down list.

12. Click the Input Data browse button , browse to C:\Lidar_workshop\Database\RawLas\, select the
LagunaRawLASfiles folder, and click Add.

13. Expand the Advanced Options, and click the Coordinate System for Input Data button .

14. Expand Projected Coordinate Systems > State Plane > NAD 1983 (US Feet), click NAD 1983 StatePlane California VI
FIPS 0406 Feet, and click OK.

15. Click OK to run the tool.
The LAS files are added to the mosaic dataset. A second footprint is generated to include the new project area and the
boundary is updated.

If you click the Full Extent button on the Tools toolbar you will see the two footprints (small green boxes) displayed at opposite ends
in the display.
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You cannot see an image of the data yet because overviews have not been generated. However, you could zoom in to a small area
within each project area if you wanted to see the data. You should build overviews for the mosaic dataset to easily view images of both
project areas and to generate statistics used to display the data. You will build overviews later in this exercise.

Part 4: Add fields to the attribute table

It's always a good idea to add some information to the attribute table that can be used when querying the data, such as the acquisition
date of the data and a name for the project or project area.

Although the true acquisition dates are not known for this data, you will be using a year for each.

Steps:

1. Right-click the Footprint layer in the table of contents and click Open Attribute Table.

2. Examine the table. You will see two entries, one for each project. If you scroll to the end of the table you will see some
fields containing information specific to the LAS files, such as Version, Point Count, Point Spacing, and the minimum
and maximum elevation values.
What are the versions of LAS files used?

___________________________________________________________

What is the average point spacing for each project area?

___________________________________________________________

What is the minimum and maximum elevation value for these datasets?

___________________________________________________________

Also, for Part 7, note the ObjectIDs for these items.

___________________________________________________________

You are going to add two additional fields.

3. Click the Table Options button and click Add Field.

4. For the Name field, type Year.

5. Click the Type drop-down menu and click Text.

6. Edit the Length by typing 20.

7. Click OK to add the field.

8. Click the Table Options button and click Add Field.

9. For the Name field, type Project, and for the Type, choose Text.

10. Click OK to add the field.

11. Click the Editor Toolbar button on the Standard toolbar.

12. Click the Editor drop-down menu on the Editor toolbar and click Start Editing.
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13. The first row under Year is the Florence dataset. Type 2010.

14. In the second row, type 2011.

15. In the first row under Project, type Florence.

16. In the second row, type Laguna.

17. Click the Editor drop-down menu and click Stop Editing.

18. Click Yes to save your edits.

19. Close the Table window and close the Editor toolbar.

Part 5: Build overviews

Mosaic dataset overviews are like raster dataset pyramids. They are lower-resolution images created to increase display speed and
reduce CPU usage since fewer rasters (or LAS files) are examined to display the mosaicked image.

With overviews, a lower-resolution copy of the data appears quickly while viewing entire mosaic datasets. When you zoom in, levels of
finer resolution are drawn, and performance is maintained because the mosaicked image is created with successively smaller areas.
This is very useful when serving the mosaic dataset as an image service or over a network. The most appropriate overview is chosen
based on the display scale. Without overviews, the entire dataset would have to be processed on the fly.

Steps:

1. Right-click the mosaic dataset in the Catalog window and click Optimize > Build Overviews.
The Build Overviews tool opens.

2. Click OK to run the tool.

3. Once completed, you can turn on the Image layer in the table of contents and zoom in to the project areas in the mosaic
dataset.

Tip: If you can't find the project area, you can open the table and right-click at the beginning of the
column and click Zoom To.

Part 6: Create a color-shaded relief from a referenced mosaic dataset

You will create a mosaic dataset that references the first mosaic dataset and add a Shaded Relief function so all users can view a
shaded relief image of this data.

This is a visually appealing way to view the elevation surface because it merges a colorized elevation model with a hillshade. This
method uses the altitude and azimuth properties to specify the sun's position.

Steps:

1. In the Catalog window, right-click the mosaic dataset and click Create Referenced Mosaic Dataset.
The Create Referenced Mosaic Dataset tool opens.

2. Change the name of the Output Mosaic Dataset to R_Relief.
The path and name will be C:\Lidar_workshop\Exercise 3\LidarCollection.gdb\R_Relief.

3. Click OK to run the tool.
This tool makes a duplicate of the first mosaic dataset. This is better than making a copy of the mosaic dataset, because
this referenced mosaic dataset is now linked to the first mosaic dataset; therefore, if any changes are made, such as
adding more data, this referenced mosaic dataset will be updated automatically.

ArcGIS 10.2 Lidar Workshop

Copyright © 1995-2013 Esri. All rights reserved. 31



4. In the Catalog window, right-click the mosaic dataset and click Properties.

5. Click the General tab.
The properties of a mosaic dataset are similar to a raster dataset.

How many bands are in this dataset?

___________________________________________________________

What is the pixel type for this dataset?

___________________________________________________________

What is the cell size?

___________________________________________________________

The cell size is represented in the units of the mosaic dataset's coordinate system. What are these units?

___________________________________________________________

6. Click the Defaults tab.
There are also a number of properties related to the mosaicking and other capabilities of the mosaic dataset. With this
dataset these defaults can generally be accepted. One property to note is specific to downloading (this appears near the
bottom of the list).

What is the maximum number of items that can be downloaded from this dataset at one time?

___________________________________________________________

What is the maximum size (in MB) for each download request?

___________________________________________________________

7. Click the Functions tab.

8. Right-click the Mosaic Function and click Insert > Shaded Relief Function.

9. Accept the defaults. Click OK to close the dialog boxes.

10. Examine the shaded relief of the project areas. You may want to turn layers on and off to see the two mosaic datasets.

Laguna project area

Note: If you look in the table of contents you will see this is now a three-band image. If you look at the
properties you will see it is also 8-bit data. The Shaded Relief function takes in the one-band,
floating-point elevation data, and outputs a three-band, 8-bit image.
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Part 7: Create a mosaic dataset with surface features

In these steps you will create another mosaic dataset which will be used to generate an elevation surface that contains all the features
on the surface.

Steps:

1. In the Catalog window, right-click the LidarCollection geodatabase and click New > Mosaic Dataset.

2. Type SurfaceWithFeatures in the Mosaic Dataset Name text box.

3. Click the Coordinate System browse button .

4. Expand Layers, click WGS_1984_Web_Mercator_Auxiliary_Sphere, and click OK.

5. Click OK to run the tool.

6. In the Catalog window, right-click the SurfaceWithFeatures mosaic dataset and click Add Rasters.

7. Click the Raster Type drop-down arrow and click Table.
The best way to make a copy of all the content in a mosaic dataset is using the Table raster type because, essentially, a
mosaic dataset is a table. When you add a mosaic dataset to a mosaic dataset, using the Table raster type, every item in
the table of the source mosaic dataset will exist as an item in the receiving mosaic dataset. If you want to add the source
mosaic dataset as a single item in the receiving mosaic dataset, then you would add it using the Raster Dataset raster
type. This option will limit what you can do because you don't have direct access to the source data.

8. Click the Input Data browse button , select the BareEarth mosaic dataset, and click Add.

9. Expand the Advanced Options.

10. In the Input Data Filter text box, type ObjectID<3.

As you noted in Part 4, the ObjectIDs for the two project areas in the attribute table are 1 and 2. This filter ensures that
only these items are added to the new mosaic dataset and that none of the overviews are added since they will need to be
generated from the new surface.

11. Click OK to run the tool.

12. In the table of contents, right-click the Footprint layer of the SurfaceWithFeatures mosaic dataset and click Open
Attribute Table.
You can see the two items you added from the BareEarth mosaic dataset.

Next, you will modify the classification properties of the inputs to produce a surface model that shows the features on the
surface.

13. Select the two rows in the table and close the Table window.

14. Right-click the SurfaceWithFeatures's Footprint layer and click Selection > Batch Edit Raster Functions.
This opens the Raster Function Editor Wizard where you will edit the functions used to rasterize the lidar data to
produce a surface that includes the points from all the classifications.

15. Click Edit Raster Function and click Next.

16. Click Search, select the LASToRaster function in the returned list, and click Next.

17. Click LAS To Raster in the column on the left.
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This function is added when the LAS files are added to the mosaic dataset. It contains all the parameters used to process
the points to create the surface image.

18. Under Return types, click Any.

19. Under Class types, click Any and click Next.

20. Click OK on the information pop-up window and review that the parameters being updated are the return types and the
class types.

21. Click Next.

22. Click OK on the error message.
The message is a warning letting you know that no settings were changed. This is correct because you want to change the
current settings for the lidar data to the defaults in this dialog box.

23. Click Finish.

24. Click the Clear Selected Features button on the Tools toolbar.

25. In the Catalog window, right-click the SurfaceWithFeatures mosaic dataset, and click Optimize > Build Overviews.

26. Click OK to run the tool.

Part 8: Examine the elevation surfaces

You now have three representations of elevation surfaces built from the lidar data using mosaic datasets which you can examine.

You'll use the Image Analysis window to help you examine the layers. The Image Analysis window supports the analysis and
exploitation of images in ArcMap with a collection of commonly used display capabilities, processes, and measurement tools. This is a
window that can be docked to the side of the application's window and either pinned open or allowed to retract to a tab.

Steps:

1. Click the Image Analysis tab to open the Image Analysis window.

2. Zoom in to one of the project areas.

3. Press CTRL and select both the SurfaceWithFeatures and BareEarth layers in the Image Analysis window, and then
check DRA.
This will adjust the stretch applied to the selected layers using only the data contained within the data frame extent, so you
can zoom in to dark or light areas and the stretch should be adjusted accordingly.
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4. To enhance the stretch a bit more, click Min-max in the resampling method drop-down menu and click Percent Clip.

5. If you toggle the SurfaceWithFeatures layer on and off, you should see the surface with and without the features, such as
houses and trees. You may need to zoom in further.

6. You can select just the SurfaceWithFeatures layer and use the Transparency slider or the Swipe Layer tool to
further examine the layers.

Part 9: Create a surface height layer

Next, you will create a surface difference layer from the BareEarth and SurfaceWithFeatures layers.

Steps:

1. In the table of contents, uncheck R_Relief.

2. Make sure the SurfaceWithFeatures layer is listed above the BareEarth layer. If they are not, you can click on one layer
and drag it to another location in the table of contents.

3. In the Image Analysis window, press the CTRL key and select the SurfaceWithFeatures layer and the BareEarth layer.

4. Expand the Processing section (if it's collapsed).

5. Click the Difference button .
A new layer is added, named Diff_Image.
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6. Right-click the Diff_Image layer and click Properties.

7. Click the Functions tab.

8. Notice that the Arithmetic function has been added to the function chain. Double-click this function to open the properties.
The Arithmetic function is used to calculate the difference between the two layers.

9. Close the Raster Function Properties dialog box.

10. Click the Symbology tab and choose a color ramp with colors so you can see the results better, then click OK to close the
dialog box.
The elevation color ramp will provide a good variation of color across the surface.

11. Select the Diff_Image in the Image Analysis window, click the resampling method drop-down menu, and click Nearest.
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12. You may also want to check DRA for this layer in the Image Analysis window.

13. Explore the Diff_Image by zooming and panning.

Part 10: Examine the profiles of the three surfaces

You can analyze and compare the surfaces with tools on the 3D Analyst toolbar. In these next steps you will generate a profile graph
for a cross section along the surfaces and compare the results.

Steps:

1. Zoom in to an area in the datasets, for example, in the Florence project area on the north side of the bridge.

2. Select the Diff_Image layer in the Image Analysis window and check DRA (if you didn't do it earlier).

3. Open the 3D Analyst toolbar and enable the ArcGIS 3D Analyst extension, if it's not already.

4. Click the drop-down arrow on the 3D Analyst toolbar and choose the BareEarth Image layer.

5. Click the Interpolate Line button on the 3D Analyst toolbar and draw a line across the surface.

6. Click the Profile Graph button to see a profile along the line.

7. Move the graph to the side.

8. Click the drop-down arrow on the 3D Analyst toolbar and choose the SurfaceWithFeatures Image layer.

9. Use the Interpolate Line tool to draw another line over the same location, and click the Profile Graph button for a
new profile.
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10. Move the graph to the side.

11. Click the drop-down arrow on the 3D Analyst toolbar and choose the Diff_Image layer.

12. Use the Interpolate Line tool to draw another line over the same location, and click the Profile Graph button for a
new profile.

13. Move the graph to the side.

14. Each graph will have a different range along the y-axis. Of the three graphs, the one you generated for the
SurfaceWithFeatures layer should have the largest range.
What is the maximum value on your graph? __________

15. Right-click one of the other graphs and click Advanced Properties.

16. Click Axis in the left column, click the Maximum tab, and click the Change button.

17. Type the value you recorded from the other graph and click OK.

18. Optionally, click Titles in the left column, change the text for the title, and click Close.

19. Repeat these last steps to change the axis and title for the other graph so you can compare the graphs more easily.
You should have three graphs showing a profile for each surface along your lines. The BareEarth graph shows the profile
along the bare surface. The SurfaceWithFeatures graph shows the surface and all the buildings, trees, and other surface
features along the interpolation line, whereas the Diff_Image graph shows only a profile of the features along the surface
as if it was flat.

20. Close the graphs.

Part 11: Downloading source files

Whether you access a mosaic dataset directly or as an image service, one of the capabilities of this dataset is you can select and
download the source files. You can choose the desired source files using the attribute table or one of the selection tools. These include
raster datasets, LAS files, or LAS datasets. Once selected, any additional associated files will be included, such as metadata files or
projection files.

The downloading capability is controlled by the properties of the mosaic dataset or the administrator of the image service; therefore, not
all mosaic datasets or image services allow you to download the source files.

If you do not want to download the source files, you can save the image that is displayed, or a part of it, by using the Export Data option.

Steps:

1. Click the Zoom In button on the Tools toolbar and zoom in to the interpolation lines.
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2. Make sure the BareEarth layer is checked on in the table of contents.

3. Use the Select Elements tool on the Tools toolbar and select the interpolation line you zoomed in to.

4. Click Selection on the main menu and click Select By Graphic.

5. Right-click the BareEarth Footprint layer in the table of contents and click Data > Download Rasters.
There will be several LAS files in the Download files list.

6. Click the Clip rasters drop-down arrow and click Clip to data frame extent.
The number of LAS files are reduced to show only those within the data frame.

Click the Download button to download the LAS files from your mosaic dataset; however, it's not necessary. These steps
were to demonstrate how this can be done from a mosaic dataset that you may share within your organization.

7. Click Close to close the dialog box.

8. Close ArcMap (without saving).

In this exercise, you have learned about mosaic datasets and their support for lidar data in ArcGIS. You were able to create mosaic
datasets, apply functions and modify the lidar data classifications to create different results, and explore how to download the source data.
In the next exercise, you will learn how to use the mosaic dataset to provide the lidar data as a service and use it in web applications.
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Exercise questions and answers
Exercise 1 questions

What is the average point spacing of each LAS file in the LAS dataset?
• The average is approximately 1.2. The values range between 0.815–1.676

What is the highest recorded point in the LAS dataset?
• 456.792

What is the version of the LAS files?
• 1.1

What classes are used by this data?
• 1 - Unassigned

• 2 - Ground

• 7 - Noise

• 9 - Water

• 10 - Reserved

What percentage of points are recorded as Unassigned?
• 84.36%

How many returns of the lidar data are displayed in the LAS dataset?
• 4

What percentage of points are recorded as first return points?
• 92.48%

How many points are recorded as noise?
• 4

Exercise 2 questions

How many points are being stored in each geodatabase row?
• Up to 3,500

What additional lidar information did you import into the multipoint feature class along with the points?
• Intensity

• Class (Classifications)

• Return_ (Return Number)

Why is it useful to store this information with the lidar points?
• To generate different terrain datasets, representing different surfaces, and generate an intensity image.

How many pyramid levels are there (levels of detail)?
• 3

How many total points are there in the terrain dataset?
• 4,729,122

What is the coordinate system of the terrain dataset?
• NAD 1983 State Plane California VI FIPS 0406 Feet

Exercise 3 questions

What are the versions of LAS files used?
• 1.1

• 1.2

What is the average point spacing for each project area?
• 1.163

• 2.705
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What is the minimum and maximum elevation value for these datasets?
• Florence: -38.02, 465.91

• Laguna: -2.87, 4505.75

Also, for Part 7, note the ObjectIDs for these items.
• 1

• 2

How many bands are in this dataset?
• 1

What is the pixel type for this dataset?
• Floating point

What is the cell size?
• 1.8288

The cell size is represented in the units of the mosaic dataset's coordinate system. What are these units?
• meter

What is the maximum number of items that can be downloaded from this dataset at one time?
• 20

What is the maximum size (in MB) for each download request?
• 2,048

What is the maximum value on your graph?
• (This value is unique to each student.)
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